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SHORTCUTS (MSFT)/COMMANDS

 Block quote/unquote (CTRL-/)

 Run project (CTRL-F11)

 Search project for strings 
(Select project, SearchFile)

 Step into, over, return (F5, F6, 
F7)

 Copy a project (CTRL-C, CTRL-
V)

 Copy a package, class file to 
another project (CTRL_C, 
CTRL-V)’

 Show variable, class, interface 
(identifier) definition (click, F3 
or Right Menu Open 
Declaration) and return back 
(ALT )

 Find identifier (variable, class, 
interface) use (Click, CTRL-
SHIFT-G, Right 
MenuReferences)

 Refactor (Click, CTRL-SHIFT-R 
or Right MenuRefactor)

 Complete identifier name 
(CTRL-Space)

 Automatic imports (CTRL-
SHIFT-O)

 JUnit

 Change Method Signature 
(Click ALT_SHIFT-C, Right 
MenuRefactor)

 Extract interface (Click 
ALT_SHIFT-C, Right 
MenuRefactor)
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FIND JDK 

http://www.oracle.com/technetwork/java/javase/downloads/index.html

Check with instructor which JDK version  to get

http://www.oracle.com/technetwork/java/javase/downloads/index.html
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FOLLOW DOWNLOAD LINK: ACCEPT LICENSE

AGREEMENT, FIND JDK FOR APPROPRIATE

PLATFORM, AND CLICK ON EXE LINK TO DOWNLOAD

EXE IN SOME TEMPORARY FOLDER
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RUN EXE AND CHOOSE JDK FOLDER
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DOWNLOAD FROM WWW.ECLIPSE.ORG (WINDOWS)

Get the latest IDE for Java 
Developers, not Indigo

http://www.eclipse.org/
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DOWNLOAD FROM WWW.ECLIPSE.ORG (WINDOWS)

Get the latest IDE for Java 
Developers, not Indigo

http://www.eclipse.org/
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EXTRACT ALL
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SELECT DESTINATION FOLDER
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CREATE SOME KIND OF SHORTCUT FOR

ECLIPSE.EXE
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RUN ECLIPSE.EXE
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SPECIFY PROJECTS DIRECTORY
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REMOVE WELCOME TAB IF IT APPEARS
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CHANGE THE JAVA VERSION: 

WINDOWPREFERENCES
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PRESS SEARCH BROWSE BUTTON
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PRESS SEARCH BROWSE BUTTON TO INSTALLED

JDK
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JRE ADDED TO ECLIPSE, SELECT IT AND CAN

EXECUTE WITHOUT ERRORS
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SOME EXPLICIT INSTRUCTIONS – FOR MAC 

(ASSUME JAVA 7)

You can get that for mac here:

 https://www.oracle.com/technetwork/java/javase/downloads/jdk10-downloads-4416644.html. Pick the Mac 
option and from there it should just be like installing any other application.

 Or you can go here:
http://download.oracle.com/otn-pub/java/jdk/7u40-b43/jdk-7u40-macosx-x64.dmg

 The problem is Eclipse won't change the compiler to use 1.7 so you will have to specify that under:
Eclipse -> Preferences -> Java -> Installed JREs

 Click "Add..." then choose "MacOS X VM"

 Next, then under directory copy/paste this:

 /Library/Java/JavaVirtualMachines/jdk1.7.0_40.jdk/Contents/Home

 Make sure it recognizes this as Java SE 7. Then name doesn't really matter.

Now go to:
Eclipse -> Preferences -> Java -> Compiler
Change the compliance level to: "1.7"

Now it probably still won't work (at least it didn't on mine)
This is because your project is still set on 1.6

So, go to:

 Project -> Properties -> Java Build Path -> Libraries
Add Library...

 JRE System Library

 "Workspace default" should be automatically there as the 1.7, but if not find the 1.7 library.
Then remove the 1.6 library

 Also you need to change the compiler being used by the project:
Project -> Properties -> Java Compiler
and make sure everything is on 1.7

Now, if you're getting an error about the main class not being found or working.

 You may just want to create a new project and when you select the 1.7 JRE.

https://www.oracle.com/technetwork/java/javase/downloads/jdk10-downloads-4416644.html
http://download.oracle.com/otn-pub/java/jdk/7u40-b43/jdk-7u40-macosx-x64.dmg
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ADD A NEW JAVA PROJECT



25

PROJECT NAME AND SEPARATE FOLDERS

The separate folder 
option puts .java source 

files in src folder and 
.class files in bin folder –

required for the auto 
grader
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SWITCH TO JAVA PERSPECTIVE (MAY GET THIS

MESSAGE)
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EMPTY PROJECT CREATED
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ADD A PACKAGE TO SELECTED PROJECT

Select project and 
File Package
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ENTER PACKAGE NAME
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EMPTY PACKAGE IN NON EMPTY PROJECT
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ADD A CLASS

Select project and 
File Class
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NAME THE CLASS
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EMPTY CLASS IN NON EMPTY PACKAGE
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EDIT THE FILE (COPY AND PASTE CODE)

package warmup;
import java.io.BufferedReader;
import java.io.InputStreamReader;
public class AGreeter {

static BufferedReader inputStream = new BufferedReader(new InputStreamReader(System.in));
public static void main(String[] args) {
System.out.println("Hello World");
if (args.length > 0) {

System.out.println(args[0]);
}
try { 

System.out.println (inputStream.readLine());
} catch (Exception e) { 

System.out.println("Could not read line");
e.printStackTrace();

}
}
}

Copy and paste code from:
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SAVE (AND COMPILE) THE FILE

FileSave or CTRL+S
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WORKSPACE, PROJECT,  SOURCE PACKAGE 

FOLDER

Source 
Package

ProjectWorkspace

Class Source
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WORKSPACE, PROJECT,  BINARY PACKAGE 

FOLDER

Binary 
Package

ProjectWorkspace

Class Object 
(Binary) Code
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EXECUTE THE MAIN METHOD ON SELECTED

CLASS

Right MenuDebug As Java 
Application

Can also select Run but Debug is more 
defensive
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FIND OR SWITCH WORKSPACE FOLDER: 

FILESWITCH WORKSPACE
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FIND PROJECT FOLDER: SELECT PROJECT, RIGHT

CLICKPROPERTIESRESOURCE
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VIEW OUTPUT IN CONSOLE WINDOW
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PROVIDE INPUT IN CONSOLE WINDOW
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THE OUTPUT AFTER ENTER



45

CONTENTS

 Install JDK

 Install Eclipse

 Connect JDK to Eclipse

 Create project

 Edit project run project

 Restore window

 Search project for strings

 Debugging

 Adding a library

 Add an existing project

 Copy a project

 Copy a package, class file 
to another project

 Delete a project

 Show variable, class, 
interface (identifier) 
definition and return back

 Find identifier (variable, 
class, interface) use

 Refactor

 Complete identifier name

 Understand, fix errors

 Automatic imports

 JUnit

 Change Method Signature

 Extract interface



46

CLOSING A WINDOW PERHAPS ACCIDENTALLY
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VANISHED CONSOLE
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WINDOWRESET PERSPECTIVE
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WINDOWSHOW VIEW

Can selectively remove and 

add sub-windows/views
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FILE SEARCH IN A PROJECT (USEFUL IN JAVA

TEACHING AND YOUR PROJECTS)

Suppose you want to search the entire project for 

some string such as some text in a Sakai 

question: such as  “println(c) displays”
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SELECT PROJECT

Select project (not the src

folder)

Suppose you want to search the entire project for 

some string such as some text in a Sakai 

question: such as  “println(c) displays”
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FILESEARCH
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SEARCH DIALOG

Search string

Scope of search

Command
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SEARCH RESULTS

Search view shown, 

console in another tab
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SEARCH RESULTS ZOOMED

Look at all the tabs 

availalale here
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MULTI FILE TEXT SEARCH FOR PRINTLN
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SEARCH RESULTS

Use CTR+SHIFT+G (shown earlier) to find 

active uses of the method
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SETTING A BREAK POINT

Double click where you 

want program to stop
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DEBUG-RUN
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STARTING THE DEBUGGER
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STOPPING AT BREAKPOINT

Debug Perspective

Next 

statemen

t to be 

executed
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EXAMINING MAIN PARAMETERS

Main 

Parameters
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STEPPING TO NEXT STATEMENT
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NEXT STATEMENT
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NEW OUTPUT AND LOCAL VARIABLE

Index gets 

initialized

println() 

executed
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STEP OVER
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STEP INTO

Call stack

Called method 

parameters
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STEP RETURN
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RESUME
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RETURNING TO JAVA PERSPECTIVE
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DEBUG LAST MAIN LAUNCHED: F11

No need to select a 

main class
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LIBRARY LOCATION ON THE WEB

Downloads

Click on the latest version (on my web page, 

not this page) to download the jar (same as 

zip) and do not unzip/unjar it



76

DOWNLOAD LIBRARY TO LOCAL COMPUTER

Do not unzip/unjar it
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SELECT PROJECT, AND PROJECTPROPERTIES

Must do this for each project!
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SELECT BUILD PATH, ADD EXTERNAL JAR
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SELECT SAVED JAR
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SELECT BUILD PATH, PROJECTS
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REMOVE SPURIOUS PROJECTS (IF ANY)
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PRESS OK TO COMMIT
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CREATE A PROJECT OUT OF EXISTING CODE: 

FILENEWJAVA PROJECT
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UNCHECK DEFAULT LOCATION BOX
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ENTER LOCATION AND NAME
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NEW PROJECT CREATED

But it will have errors because of missing  

ObjectEditor library
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COPYING A PROJECT

Select project, CTRL CTRL-V
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COPY TYPES (CLASSES, INTERFACES, ENUMS) 

FROM PACKAGE TO ANOTHER: COPY

Select type(s) in source project 
and package and press CTRL-C 

(or FileCopy right menu 
item)
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COPY TYPES FROM ONE PACKAGE TO ANOTHER: 

PASTE

Select package in destination 
project and package and press 

CTRL-V (or FilePaste right 
menu item)
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COPYING CLASSES FROM ONE PACKAGE TO

ANOTHER: NEW CLASS IN NEW PACKAGE AND

PROJECT

Repackaged type added (and its 
imports are changed to other copied 
types if multiple types are copied and 

pasted together)
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DELETING A PROJECT

Right click project and delete. 
Usually not a good idea to delete 

project on disk, can always use the 
OS to do so, which will put it in the 

recycling bin
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JUMPING TO IDENTIFIER DEFINITION AND

NAVIGATION STACK

F3 when cursor is a start 
of an identifier

Makes Eclipse take you to 
the definition of the 

identifier in an edit window

ALT + Back Arrow takes 
you back where you 

came from,  a la 
Browser back button, 
can execute multiple 

times  to back in in the 
stack of visited points

ALT + Forward Arrow 
goes forwards in the 
navigation stack a la 

browser forward 
button
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FIND THE USES

CTRL-SHIFT-G when cursor is a 
start of an identifier

Makes Eclipse show the 
methods that reference the 
identifier in the search tab

Double clicking a method 
reference 

Makes Eclipse show the method 
and highlight all references of 

the identifier
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1

MENUREFACTORRENAME IDENTIFIER:  ALT + 

SHIFT + R

Select type, right 
menuRefactorRename

All references will be updated!
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3

COMPLETE IDENTIFIER: CTRL + SPACE AFTER

PREFIX

public static final long NUMBER_OF_LARGE_FACTORIAL_COMPUTATIONS
= 1000000;

Give file name
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UNDERSTAND AND CORRECT ERRORS
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CORRECT ALL IMPORT ERRORS IN FILE: CTRL + 

SHIFT + O

In Eclipse press CTRL-SHIFT-O to 

automatically import all used types that 

need to be imported but have not been 

imported

If class is in more than one package, 

Eclipse gives a choice 

All unused imports are also removed

Can select multiple types or a project to 

refresh all imports in the selected 

types/project 
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JUNIT: NEW CLASS WITHOUT MAIN
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JUNIT: INSTALL JUNIT
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JUNIT ADDED AND IMPORTED
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RUN JUNIT
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JUNIT RESULT



11

4

RETURNING TO JAVA PERSPECTIVE
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TWO OTHER USEFUL BUT COMPLICATED

REFACTOR OPTIONS

Change method signature

Will try to update references to match the signature, 
which can be erroneous

Maybe better to get all references and update them 
individually for both purposes

Extract interface of class C

Will create interface of selected public methods and 
will make the interface the type of all variables 

declared to be of class type

Adds potentially unwanted comments to method 
headers and sometimes updates to references have 

not worked in the past for me
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SUPPLY USER ARGUMENT: 

Right MenuDebug As Debug Configuration
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SELECT MAIN CLASS IN CONFIGURATION
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CREATE A PROJECT OUT OF EXISTING CODE: 

FILENEWJAVA PROJECT
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UNCHECK DEFAULT LOCATION BOX
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ENTER LOCATION AND NAME
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NEW PROJECT CREATED

But it will have errors because of missing  

ObjectEditor library
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SPECIFY AND APPLY ARGUMENT IN ARGUMENT

TAB AND PRESS DEBUG

Argument must be in 

quotes. Args[0] = “Ca 

Va”

Without quotes Java 

will make each word a 

separate argument 

(args[0] = “Ca”, args[1] 

= “Va”
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EXECUTE WITH SUPPLIED ARG
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ARG PRINTED, PROGRAM, STILL RUNNING, 

WAITING FOR INPUT

Button available in 

both Debug and Java 

Perspective, only of 

them is active
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TERMINATED PROGRAM


